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Interface 
The Artisan Interface consists of 7 different sections. These have been colour coded and 
highlighted on the image below: 

Keyword Definition 

Menu Bar The Menu Bar can be used to access a variety of features through drop-down lists. 

Tab Bar The Tab bar contains tabs for navigating between tasks in Artisan.  

Sub-Tab Bar The Sub-Tab bar contains tabs for navigating between tasks in Artisan. 

Render Window The Render Window holds your current scene.  

Content Panel The Content Panel stores materials, lighting schemes and backgrounds. 

Toolbar  The Toolbar contains buttons for performing various tasks within Artisan.  

SnapShots Panel The SnapShots Panel stores all the SnapShots you have taken. 
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Menu Bar 
File 

• Save (Ctrl+S): Saves the current session and SnapShots to disk. 

• Exit (Alt+F4): Closes Artisan. 

Edit 
• Undo (Ctrl+Z): See Toolbar section. 

• Redo (Ctrl+Y): See Toolbar section. 

• Reset Session: Resets the current session back to state it was when started. 

• Preferences: See Preferences section. 

Camera 
• Lens: Sets the camera’s focal length. 

• Aspect Ratio: Sets the image width and height. 

• Up Vector: Defines which axis is pointing up. 

• Orientation: Sets the image orientation to either portrait or landscape. 

• Animations: Rotates the model in real time. 

• Reset Camera: Resets the camera position and orientation to the state upon 
starting the session. 

Navigation 
• Examine (O): See Navigation. 

• Explore (W): See Navigation. 

• Drag: See Navigation. 

• Look: See Navigation. 

• Track: See Navigation. 

• Fit to Model: See Navigation. 

• Standard Views: Moves the camera to set positions around the model. 

Render 
• See Rendering Controls 

• launch Render Monitor: Opens the Render Monitor application, to look at 
tasks being rendered using Network Rendering. 

SnapShots 
• Create SnapShot: Takes a SnapShot of the current scene. 

• Delete All SnapShots: Deletes all the current SnapShots. 

• Show Files: Opens the folder where the SnapShot files are stored. 

• Print All SnapShot Renders: Prints all high quality renders that are attached to 
the SnapShots. 
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• Print All Interactive Renders: Prints all interactive renders that are attached to 
the SnapShots. 

Archive 
• Import: Imports an archive from file. 

• Add All Materials: Adds all materials in a scene to an archive. 

• Add Background: Adds the current background to an archive. 

• Add All SnapShots: Adds all SnapShots to an archive. 

Help 
• Help (F1): Opens the help documentation 

• About: Displays program information, version number and copyright. 

 
 

Tabs 
Materials 

• Materials: Contains full material definitions, including: colour, finish and bump 
components. Applying a material will completely override the material 
applied in the CAD application. 

 
• Finishes: Contains reflectance and transparency properties such as mirror or 

glass. 

 
• Bumps: Makes a surface appear rough or to have a pattern based on 

different heights on the surface. 

 
• Material archives: Create an archive containing materials used in your 

model. 

 
• Finish: Specifies which finish is applied. 

• Bump: Specifies which bump map to use. 

• Geometry: Allows geometry to be hidden in order to allow material editing 
of obscured geometry.  
* This feature is not included in the Artisan Undo and Redo system. 
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Lighting 
• Architectural: Weather based lighting schemes designed for use when 

rendering views of architectural models. 

 
• Product: 

 
o Natural Lighting: 360-degree HDR images of real exteriors 

and interiors providing natural lighting and reflections. 

o Studio Lighting: Photographer’s studio setups using HDR 
lighting. 

o Softbox Lighting: Even and diffused lighting schemes. 

Backgrounds 
• 2D Scenes: 

 
o Interior: Photographic 2D backgrounds suitable for situating 

models in an interior and exterior environment. 

• 3D Scenes: 360-degree spherical panoramas representing different weather 
effects and skies. 

 
• Background Archives: Allows you to store your favourite backgrounds in an 

archive. This is particularly useful if you make use of custom backgrounds; for 
example image backgrounds. 

SnapShots 
• SnapShots: Provides tools to set different aspects of quality for the current 

render and for the SnapShots that you have defined. 

• SnapShot Archives: Enables you to share SnapShots across models. 

 
 

 

Toolbar 
• Undo (Ctrl+Z): Undo changes made to the current session. 
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• Redo (Ctrl+Y): Cancel any undo. 

 
• Examine (O): See Navigation Controls. 

 
• Explore (W): See Navigation Controls. 

 
• Drag: See Navigation Controls. 

 
• Look: See Navigation Controls. 

 
• Track: See Navigation Controls. 

 
• Fit to Model: See Navigation Controls. 

 
• Preview Render: See Rendering Controls. 

 
• Full Render: See Rendering Controls. 

 
• Cancel Render: See Rendering Controls. 

 
• Save Last Render to File: See Rendering Controls. 

 
• Render to Sub-Image: See Rendering Controls. 

 
• Create SnapShot: See Rendering Controls. 

 
• Edit Background:  

 
o Texture: Supply your own image as a background. 
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o Gradients: Change colours when current background is 
gradated. 

• Edit Light Position: provides tools for positioning the sun and environment. 

o Sun Height: Set the height of the sun above the horizon. 

o Sun Rotation: Set the rotation of the sun 

o Edit Lighting Position: Rotate the 3D background, lighting 
image and reflections on your model. 

 
• Edit lighting: The balance between ambient, artificial and studio lighting can 

be adjusted. In addition, the shadow properties can be edited.  

 
o Lighting 

 Use artificial lighting: Controls whether 
application defined artificial lights will be 
included in the rendered image. 

 Artificial intensity scale: Increases or 
decreases the effect of all the 
application-defined lights. 

 Ambient intensity scale: Increases or 
decreases the level of ambient lighting in 
the image. 

o Reflected Environment 

 Reflect Image: By default, reflections will 
match the HDR Image used in the lighting 
scheme. It is possible to override the 
image that is reflected. 

 File name: The location 
of the file being used. 

 Intensity Scale: Sets the 
reflection intensity to 
alter the power of the 
reflection. 

 Reflect Current Background: Lighting 
scheme reflections are ignored. Instead, 
the current background is reflected. 

o Lighting Detail 

 Model Size: Reduce this if you are viewing 
the model close-up or are viewing a 
single room in a larger building and the 
lighting quality is not sufficient. 

o Shadows 
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 Drop Shadow: Controls whether a drop 
shadow is displayed under the model 

 Shadow Quality: Sets 
the sample quality of 
the drop shadow. 

 Contrast: Sets the 
brightness of the drop 
shadow. 

 Sun Shadow: This check box controls 
whether or not a shadow is cast from sun 
or from the spot lights (if defined on the 
light studio). 

 Brightness: Sets the 
intensity of the shadows. 

 Reflection: Controls whether the model is 
reflected in the base plane. 

 Brightness: Makes the 
reflection appear 
brighter or darker 

 Blur: Makes the 
reflection more or less 
distant 

• Select Paint material: Click on Select Paint Material then left click on the 
material you wish to copy. With the Select Paint Material tool active, right 
click to paste the copied material. 

 
 

Navigation 
• Examine (O): Left Mouse Button moves the camera around the model. 

 
• Explore(W): Left Mouse Button walks the camera towards and away from the 

model whilst looking left and right. 

 
• Drag: Left Mouse Button moves the camera up, down, left and right without 

changing its direction. 
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• Look: Left Mouse Button moves the cameras direction without changing its 
position. 

 
• Track: Left Mouse Button walks the camera toward and away from the 

model, as if on a rail. 

 
• Fit to Model: Moves the camera so the entire model can be seen in the 

render window. 

 
• Mouse Wheel: Scroll will track. Press and hold will drag. 

• Spacebar: Fits the camera to model extents. 

• Shift+ Spacebar: Moves the camera to centre of the model. 

• Left Mouse Button + Right Mouse Button: Held at the same time will drag. 
 

Rendering and SnapShot Controls 
Rendering Controls 

• Preview Render: Renders the scene using the Preview Render quality settings 
that can be set in Edit > Preferences. By default, these are set low to 
produce an image faster. 

 
• Full Render: Renders the scene using the Full Render quality settings that can 

be set in Edit > Preferences. By default, these are set high to produce a high 
quality image. 

 
• Cancel Render: Stops an in progress Preview Render or Full Render. This does 

not remove the image from screen until the scene changes. 

 
• Save Last Render to File: Saves the last Preview Render or Full Render to a 

file. 

 
SnapShot Controls 

• Create SnapShot: Create a SnapShot of the current scene (camera, 
materials, lighting and background) for rendering later. 



 
 

 11 

 
• Show in Explorer: Opens the directory where the SnapShots are stored. 

 
 
 

 

Preferences 
• Preferences: Options to change the general settings for Artisan, the OpenGL 

render settings and the software render settings 

o General 

 Textures Folder: Add a location(s) to 
search for textures used in custom 
materials. Multiple folders should be 
separated by semicolons. Use this if you 
have physically moved the texture files 
after creating a custom material. 

 Language: Sets the language for Artisan. 
By default this is set to your Operating 
Systems language. A restart is required if 
you make a change to the current 
selection.  
 
The supported languages in Artisan are: 

 English (UK) 

 German 

 Spanish 

 French 

 Italian 

 Japanese 

 Korean 

 Polish 

 Portuguese 

 Russian 

 Chinese (Simplified) 

 Model Style: Sets the lighting and 
background for new models. This option 
does not need to be changed every time 
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you open Artisan, it is meant to help if you 
always open one type of model. 

 Icon Size: Sets the size of the icons used in 
the right tabs. 

o Real-Time 

 Quality: Sets the quality of the real-time 
preview. Higher values display a more 
accurate image, while lower values 
increase performance. 

 Use High Resolution Textures: Untick this to 
reduce memory used by your video card. 
It does not affect software rendering. 

 Enable real-time shadows: Enables 
shadows in real-time. Untick this to 
increase your frame rate. 

o Software Render 

 Render Quality: See render 
quality settings 

o Reset All: Resets the current settings back to its original 
state. Requires a restart of Artisan. 

 

Hotkeys 
• Ctrl-S: Save 

• Alt-F4: Exit 

• Ctrl-Z: Undo 

• Ctrl-Y: Redo 

• O: Examine 

• W: Explore 

• F1: Help 
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User Guides 
Applying a material to an object 
Applying a Background to a scene 
Applying a Lighting Scheme 
Creating and applying a SnapShot 
Rendering a SnapShot 
Speeding up Artisan 
Create your own materials 
Making a Material Have a Different Finish 
Applying part of a SnapShot to your scene 
Applying part of your scene to a SnapShot 
Rending part of the scene using Sub-Image rendering 
Creating an Archive of Materials 
Creating an Archive of Backgrounds 
Creating an Archive of SnapShots 
Exporting and importing Archives or content packs 
Copying and pasting colours, finishes and bumps 
Adding your own 2D background 
Hiding parts of your model from view 
Showing files and images in your file explorer 
Changing the size of the camera lens 
Changing the position of lights in your scene 
Changing the side of your model that faces up 
Changing the colour of a material 
How to effectively use lighting schemes 
Render quality settings 
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Applyings a material to an object 
Artisan makes applying a material easy, with a drag-and-drop mechanism that will replace 
the CAD application texture and/or colour. This will give you photorealistic quality materials in 
a few mouse clicks. 

 

To apply a material to an object: 

1. Select the Materials tab from the tab bar. 

 

2. Select the Materials tab from the sub-tab bar on the right hand side. 

 

3. Choose a material group from the drop-down menu then find the material you want to 
apply from the content panel. 

4. Click and hold down the left mouse button on the material, then drag it onto the 
model. 

5. Release the left mouse button and the material will be applied to the part of the model 
under the cursor. 

You can change the properties of a material on the model by right clicking on it then 
choosing Edit Material. 

 

Applying a Background to a scene 
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Artisan offers the ability to apply a number of pre-defined backgrounds to your scene. 

 

To apply a background to a scene: 

1. Select the Backgrounds tab from the tab bar. 

 

2. Select the 2D Backgrounds, 3D Backgrounds or Archives tab from the sub-tab bar on 
the upper right hand side. 

   

3. Choose a background group or Archive from the drop-down menu. 
4. Find a background you want to apply from the content panel. 
5. Click and hold down the left mouse button on the background, then drag it onto the 

render window. 
6. Release the left mouse button and the background will be applied to the scene. 

You can change the properties of a background by clicking the Edit Background button in 
toolbar.  

 

 

Applying a Lighting Scheme 
Artisan offers pre-defined lighting schemes. These vary in complexity and accuracy to give 
you the most realistic looking lighting for your scene. 

 

To apply a lighting scheme to a scene: 

1. Select the Lighting tab from the tab bar. 

 

2. Select the Architectural, or Product tab from the sub-tab bar on the upper right hand 
side. 
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3. Choose a lighting group from the drop-down menu then find the lighting you want to 
apply from the content panel. 

4. Click and hold down the left mouse button on the lighting scheme, then drag it onto 
the render window. 

5. Release the left mouse button and the lighting scheme will be applied to the scene. 
This can take some time depending on the complexity of the scheme. 

You can change the properties of a lighting scheme by clicking the Edit Lighting or Edit Light 
Position buttons in the toolbar. 

   

Creating and applying a SnapShot 
SnapShots store all the data from your scene, so you can quickly and easily recreate it. 
SnapShots mean that you can make and save changes to an old scene without having to 
recreate it from scratch. 

 

To create a SnapShot of a scene: 

1. Click on the Create SnapShot button in the toolbar. The SnapShot will appear in the 
SnapShots panel. 

 

 

To apply a SnapShot: 

1. Click and hold down the left mouse button on a SnapShot in the SnapShots panel. 
2. Drag the SnapShot onto the render window then release the left mouse button and the 

SnapShot will be applied to the scene. This can take some time depending on the 
lighting scheme and shadows within the SnapShot. 

You can create Archives of your SnapShots by highlighting them in the SnapShots panel, right 
clicking and selecting ’Add SnapShot to Archive’. You can then use these with other models 
to apply individual aspects or the whole SnapShot. 

 

Rendering a SnapShot 
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Artisan offers you two ways to render an image. You can render a SnapShot or set of 
SnapShots, or you can render progressively in the render window and save the image that is 
produced. 

 

To render a SnapShot or sets of SnapShots: 

1. Select the SnapShots tab from the tab bar. 

 

2. If not already active, select the Render tab from the sub-tab bar on the upper right 
hand side. This will change the content panel to show options for rendering SnapShots. 

 

3. Click on the SnapShot that you would like to render from the SnapShot panel. When the 
SnapShot is selected, a blue border will appear around the image. 

To render more than one SnapShot, you can hold the Shift key and click on more 
SnapShots to highlight a series, or hold the ctrl key down to add individual SnapShots. 
Another way to select multiple SnapShots is to hold the left mouse button down in the 
space around the SnapShots then drag a selection box over the ones you want to 
render. 

4. Change the render options in the content panel to your preferences: 

o Change the file type by choosing one from the Output Format drop-
down menu. 

o Change the image resolution by choosing a size from the Longest 
Side (pixels) drop-down menu, or by entering your own value. The 
shortest side will be calculated based on the aspect ratio of the 
SnapShot. 

To change the aspect ratio of a SnapShot, apply the SnapShot to the scene, change 
the aspect ratio using the menu bar item 'Camera > Aspect Ratio' then create a new 
SnapShot using the Create SnapShot button. 

o Set the render, material and lighting quality by changing the values in 
the corresponding drop-down menus. 

Choosing the quality value ‘SnapShot’ will take the last known setting used for each 
SnapShot. 

5. Click on the Render Selected SnapShots button. 
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6. The results of the rendering process will be delivered into the SnapShots folder beside 
your CAD model file. You can access the images quickly by double clicking each 
SnapShot in the SnapShot panel, or by clicking the Show Files button. 

 

To perform a progressive render in the render window: 

1. Click on either the Preview Render or the Full Render button in the toolbar. 

  

The Preview Render and Full Render qualities can be set by choosing Edit > Preferences, 
then by selecting the Software Render tab. 

2. Rendering will take place in the render window with the image becoming clearer as it 
progresses. You can stop the rendering process at any time by clicking on the Cancel 
Render button. 

 

 

To save your Preview or Full render: 

1. After the scene has been rendered on screen, click on the Save Last Render to 
File button in the toolbar. 

 

2. Specify the file location to save the render to, and then click Save. 

 

Speeding up Artisan 
Artisan uses different parts of your computers hardware for different operations. You can 
increase Artisan’s performance by upgrading certain parts of your computer. 

Although not always the case, as a general rule:  

•  To improve the speed at which you navigate the render window, you can upgrade your 
graphics card. 

•  To improve the speed of renders, you can upgrade your processor.  
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•  To improve the speed at which large CAD models are loaded into Artisan, you can increase 
the amount of memory in your computer. 

 

Create your own materials 
Artisan allows you to create your own materials and apply these to your model. This allows you 
to create truly unique models that are customised to your exact specifications. 

 

To create a material: 

1. Select the Materials tab from the tab bar. 

 

2. Select the Materials tab from the sub-tab bar on the upper right hand side. 

 

3. Choose the User Defined material group from the drop-down menu. 
4. Click and hold down the left mouse button on the Texture or Filter Texture materials, 

then drag it onto part of the model. 

Filter Texture is for grey scale textures that take on the colour you choose. 

5. Release the left mouse button and the custom texture place-holder will be applied to 
the part of the model under the cursor. 

6. Right click on the custom texture place-holder that has been applied to your model, 
and choose Edit Material from the drop-down list. 

7. Click on the Edit button then navigate to your texture in the file explorer window. 

Artisan supports .bmp, .jpeg, .lgi, .tga, .png, and .tif file formats. 

8. Click on Open. 
9. Change the material options in the Edit Materials panel to your preferences. 

For more information on what the options do, see Edit Materials. 

10. Click OK and your custom texture will be applied to the geometry of the model. 

Changing the Finish on your Material 
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Artisan allows you to change the finish that is applied to a material. Finishes add reflectance 
and transparency properties, which can result in a more realistic looking material. 

 

To change the finish: 

1. Select the Materials tab from the tab bar. 

 

2. Select the Finishes tab from the sub-tab bar on the upper right hand side. 

 

3. Choose a finishes group from the drop-down menu then find the finish you want to 
apply from the content panel. 

4. Click and hold down the left mouse button on the finish, then drag it onto part of the 
model. 

5. Release the left mouse button and the finish will be applied to the part of the model 
under the cursor. 

 

Applying part of your scene to a SnapShot 
You can apply materials, lighting schemes, backgrounds and camera settings from your 
current scene to your other SnapShots. 

 

To apply part of a scene to a SnapShot: 

1. Right click on a SnapShot in the SnapShots panel. 
2. Choose Update SnapShot from the drop-down menu. 
3. Choose your preference to apply to the SnapShot: 

• Materials will update the SnapShot with the materials from the current scene. 

• Lighting will update the SnapShot with the lighting scheme from the current 
scene. 

• Background will update the SnapShot with the background from the current 
scene. 

• Camera will update the SnapShot with the camera settings from the current 
scene. 
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• All will update the SnapShot with materials, lighting, camera settings and 
backgrounds from the current scene. 

Updating the content of a SnapShot will not update it’s icon. You can apply the SnapShot 
after you’ve made the changes and create a new SnapShot if you need to update the icon. 

 

Applying part of a SnapShot to your scene 
Artisan allows you to apply materials, lighting schemes, backgrounds and cameras from other 
SnapShots to your current scene. This means you can try different scene setups quickly and 
easily. 

 

To apply part of a SnapShot to your scene: 

1. Right click on a SnapShot in the SnapShots panel. 
2. Choose Update Current Scene from the drop-down menu. 
3. Choose your preference to apply to your scene: 

• Materials will update the scene with the materials from the selected 
SnapShot. 

• Lighting will update the scene with the lighting scheme from the selected 
SnapShot. 

• Background will update the scene with the background from the selected 
SnapShot. 

• Camera will update the scene with the camera settings from the selected 
SnapShot. 

• All will update the scene with materials, lighting, camera settings and 
backgrounds from the selected SnapShot. 

 

Rendering part of the scene using Sub-
Image rendering 
Artisan offers you the ability to render any chosen part of your scene as a high-quality image. 
This means you can, for example, view a new material you have applied to your model 
without rendering the entire scene. 

 

To render a part of your scene: 
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1. Click on the Render to Sub-Image button in the toolbar. 

 

2. Move the mouse cursor onto the render window. 
3. Click and hold down the left mouse button on part of the scene, then drag it to over 

the area you wish to render. 

Rendering will begin automatically when you have selected your area, using the “Full Render” 
quality settings. To stop using Sub-Image rendering, click the Sub-Image Render button again. 

 

Creating an Archive of Materials 
Artisan allows you to add your materials to an Archive that can be accessed any time within 
Artisan, or exported to a location on your computer. With Archives, Artisan makes storing and 
sharing your materials easy. 

 

To add all the materials in your scene to an Archive: 

1. Click on the Archive menu bar item. 
2. Choose Add All Materials from the drop-down menu. 
3. Click on your preference in the dialog: 

• To create a new Archive to store materials in, click on Create then enter a 
name for the new archive. 

• To add materials to an existing Archive, select the Archive from the drop-
down menu and click Add. 

 

To add a specific material in your scene to an Archive: 

1. Right click on the geometry of your model that has the material applied you would like 
to add to an Archive. 

2. Choose Add Material to Archive from the right click menu. 
3. Click on your preference in the dialog: 

• To create a new Archive to store materials in, click on Create then enter a 
name for the new Archive. 

• To add materials to an existing Archive, select the Archive from the drop-
down menu and click Add. 

You can access a materials Archive by selecting the Materials tab, then by selecting the 
Archives tab from the sub-tab bar on the upper right hand side. After this, select an Archive to 
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access from the drop-down menu.  

  

 

Creating an Archive of Backgrounds 
Artisan allows you to add your backgrounds to an Archive that can be accessed any time 
within Artisan, or exported to a location on your computer. With Archives, Artisan makes 
storing and sharing your backgrounds easy. 

 

To add the background in your scene to an Archive: 

1. Click on the Archive menu bar item. 
2. Choose Add Background from the drop-down menu. 
3. Click on your preference in the dialog: 

• To create a new Archive to store backgrounds in, click on Create then enter 
a name for the new Archive. 

• To add backgrounds to an existing Archive, select the Archive from the 
drop-down menu and click Add. 

You can access a backgrounds Archive by selecting the Backgrounds tab, then selecting the 
Archives tab from the sub-tab bar on the upper right hand side. After this, select An Archive to 
access from the drop-down menu. 

  

 

Creating an Archive of SnapShots 
Artisan allows you to add your SnapShots to an Archive that can be accessed any time within 
Artisan, or exported to a location on your computer. Archives make storing and sharing your 
SnapShots easy. 

 

To add SnapShots to an Archive: 

1. Click on the Archive menu bar item. 
2. Choose Add All SnapShots from the drop-down menu. 
3. Click on your preference in the dialog: 
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• To create a new Archive to store SnapShots in, click on Create then enter a 
name for the new Archive. 

• To add SnapShots to an existing Archive, select the Archive from the drop-
down menu and click Add. 

 

To add a specific SnapShot to an Archive: 

1. Right click on a SnapShot in the SnapShots window.  
You can select more than one at a time by holding down the Ctrl key and clicking on 
multiple SnapShots. 

2. Choose Add SnapShot to Archive from the drop-down menu 
3. Click on your preference in the dialog: 

• To create a new Archive to store SnapShots in, click on Create then enter a 
name for the new Archive. 

• To add SnapShots to an existing Archive, select the Archive from the drop-
down menu and click Add. 

You can access a SnapShots Archive by selecting the SnapShots tab, then selecting the 
Archives tab from the sub-tab bar on the upper right hand side. After this, select an Archive to 
access from the drop-down menu. 

  

 

Exporting and importing Archives or content 
packs. 
Artisan allows you to export Archives that you have created to a location on your computer. 
You can also import Archives into Artisan. This means you can easily store and share parts of 
your scene. 

 

To export an Archive: 

1. Select the Materials, Backgrounds or SnapShots tab. 

   

2. Select the Archives tab from the sub-tab bar on the upper right hand side. 
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3. Choose an Archive group from the drop-down menu. 
4. Click on the Export Archive button at the bottom of the content panel. 
5. Navigate to the folder you would like to save to in the file explorer window, then enter a 

name and click on Save. 

 

To import an Archive or content pack: 

1. Click on the Archive menu bar item. 
2. Choose Import from the drop-down menu. 
3. Navigate to and select your .lwz Archive in the file explorer window, then click Open. 

 

Copying and pasting colours, finishes and 
bumps 
Artisan offers you the ability to copy a material from one piece of geometry to another. This 
method will save you time and avoid you having to recreate materials each time. 

 

To copy a material from one piece of geometry to another: 

1. In the render window, move the mouse cursor over a piece of geometry to copy and 
right click. 

2. Choose Material from the drop-down menu. 
3. Click on your preference from the sub-menu: 

o To take a copy of the texture applied to this geometry, choose Copy 
Colour. 

o To take a copy of the bump map applied to this geometry, 
choose Copy Bump. 

o To take a copy of the finish applied to this geometry, choose Copy 
Finish. 

o To take a copy of the texture, bump map and finish applied to this 
geometry, choose Copy. 

 

4. Move the mouse cursor over the piece of geometry you would like to paste to and right 
click. 

5. Choose Material from the drop-down menu. 
6. Click on the Paste button in the sub-menu. 

You can reset the materials, bumps and finishes on a piece of geometry back to its imported 
state by clicking the Reset button in the sub-menu. 
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Alternatively, you can use the Paint Material tool. 

 

Adding your own 2D background 
Artisan allows you to add backgrounds using images from your computer to create bespoke 
scenes. 

 

To create a Custom 2D background: 

1. Select the Backgrounds tab. 

 

2. Select the 2D Scenes tab from the sub-tab bar on the upper right hand side. 

 

3. Choose the 2D User Defined group from the drop-down menu. 
4. Click and hold down the left mouse button on the Custom Image background, then 

drag it onto the model. 

 

5. Release the left mouse button and the place-holder background will be applied to 
your scene. 

6. Click on the Edit button in the Edit Background dialog that appears, then navigate to 
your chosen image in the file explorer window. 

7. Click on Open. 

Artisan supports .bmp, .jpeg, .lgi, .tga, .png, and .tif file formats. 

 

Hiding and Showing Geometry 

qthelp://com.lightworkdesign.irayplus/doc/help/toolbar/toolbar.html#paintmaterial
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You can hide specific parts of your model's geometry, allowing you to view and edit obscured 
geometry easily. 

 

To hide part of your model from view: 

1. Move the mouse cursor over the piece of geometry you would like to hide in the render 
window and right click. 

2. Choose Geometry from the drop-down menu. 
3. Click on Hide from the sub-menu. 

This will stay hidden until you "Show All" 

 

Showing files and images in your file explorer 
By default, your renders are stored in a predefined directory in the same location as your CAD 
file. 

 

To view your renders in the default file directory: 

1. Click on the Show Files button in the toolbar. 

 

Changing the size of the camera lens 
Artisan allows you to mimic a camera lens by changing its size to alter the field of view. This 
means you can customise your viewports for more accurate rendered images. 

 

To change your Cameras Lens: 

1. Click on the Camera menu bar item. 
2. Choose Lens from the drop-down menu. 
3. Click on your preference of lens size from the list. 

Changing the position of lights in your scene 
You can change the position that the lights are cast from, allowing you to cast realistic looking 
shadows that mimic your backgrounds light position. 
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To change the position of the lights in your scene: 

1. Click on the Edit Light Position button in the toolbar. 

 

2. Choose your preferences from the dialog that appears: 

o Adjust the Sun Height slider to change the vertical angle that sunlight 
is cast from. 

o Adjust the Sun Rotation slider to change the horizontal angle the 
sunlight is cast from. 

o Adjust the Rotation slider to affect how the the image based lighting 
and the image being reflected onto your model’s surfaces. 

 

 

Changing the side of your model that faces 
up 
You can change the Up Vector of the model, this changes which side faces up. 

 

To change the Up Vector: 

1. Click on the Camera menu bar item. 
2. Click on Up Vector from the drop-down list. 
3. You can click on different axes to change which axis points up. 

It may take a few moments for the changes to be applied as Artisan processes the difference 
in lighting. 

 

Changing the colour of a material 
A material will have a default colour, but you are able to change this (some materials cannot 
have their colour changed). 

 

To change a materials colour: 
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1. Right click on the model where you want to change the colour and choose Edit 
Material from the drop-down menu. 

2. Look for the Colour heading then click on Edit. 
3. Choose the colour you would like then click OK. 
4. Click OK on the Edit Material window. 

 

How to effectively use lighting schemes 
Lighting in Artisan is split into two categories, architectural and product. This guide describes 
what schemes to use in what situations, and how best to adjust them to fit your scene. For 
details on how to apply a lighting scheme, see here. 

 

Architectural 
Architectural lightings schemes are divided up into two categories, interior and exterior. 
Interior lighting schemes are designed to offer softer lighting and shadows, where as exterior 
lighting offers darker shadows and stronger lighting to mimic the sun.  
 
Both interior and exterior night take any lighting out of your scene except lights placed there 
within your cad application (if supported).  
 
Interior 
Interior lighting schemes should be used when rendering the interior of an architectural model. 
If you are looking into the interior of a model from the outside, you will still need to use an 
interior lighting scheme as this will appropriately light the area that you are looking to render. 
 
Exterior 
Exterior lighting schemes should be used when rendering the exterior of an architectural 
model. Again, you will need to use these schemes if you are looking to render a scene that 
shows the outside of a model from the inside. This will appropriately light the area that you are 
looking to render.  
 
Product 
The product lighting schemes are split into three sub categories: studio, natural and softbox.  
Studio lighting is designed to mimic the bright lights within a studio environment. Natural 
lighting is designed to mimic the lighting found in outdoor environments. Softbox lighting 
applies softer shadows to your scene (softbox lighting may not work well with certain 
materials). 
 
Finally, within both categories you have the fast ambient and sun/distant lighting schemes. 
These are lower quality lightings schemes, designed for quick renders or lower performance 
computers.  
 
 

qthelp://com.lightworkdesign.irayplus/doc/guides/applyLighting.html
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Render quality settings 
The quality of the materials, lighting and overall render can be adjusted in the Edit > 
Preferences dialog. This guide details the changes that will be made to your render by 
adjusting these settings. 

 

The software render quality settings are divided into two sections, preview and full. 
 
Preview Render 
This defines the quality of the render when you press the 'Preview Render' button. By default, it 
is set to low, low, low to enable faster rendering of your scene.  
 
Full Render 
This defines the quality of the render when you press the full render button or you render your 
SnapShots to file in the SnapShots tab. 
 
Render Quality 
Increasing Render Quality will increase the effective resolution at which the image is created. 
Very thin object such as railings or the gaps between the components of a cupboard will 
require a higher render quality to appear correctly.  
 
Lighting Quality 
To bounce the light, Artisan estimates the amount of light reaching parts of the scene. 
Increasing the Lighting Quality means Artisan can produce more precise estimates and more 
accurate lighting effects.  
 
Material Quality 
Materials with a ‘glossy’ finish will take longer to render accurately. The ‘Low’ setting of 
Material Quality causes the ‘glossy’ effect to be switched off and replaced with a faster 
mirror-style reflectance. Higher setting of Material Quality cause an increasingly realistic 
blurring to be calculated.  
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Getting Started with Artisan 
This getting started guide is designed to give you an overview of the Artisan workflow.  
 
The Help Documentation and User Guides cover Artisan in more detail, explaining all the 
interface and features of the software.  
 
This guide will cover the 4 most important steps of the Artisan workflow: 

•  Step 1: Adding materials, finishes and bump maps to your model 
•  Step 2: Choosing a Lighting Scheme for your model 
•  Step 3: Choosing a 2D or 3D background for your model 
•  Step 4: Creating and Rendering SnapShots of your model 

qthelp://com.lightworkdesign.irayplus/doc/help/help.html
qthelp://com.lightworkdesign.irayplus/doc/guides/guides.html
qthelp://com.lightworkdesign.irayplus/doc/about/gettingStarted.html#one
qthelp://com.lightworkdesign.irayplus/doc/about/gettingStarted.html#two
qthelp://com.lightworkdesign.irayplus/doc/about/gettingStarted.html#three
qthelp://com.lightworkdesign.irayplus/doc/about/gettingStarted.html#four
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Step 1: Adding materials, finishes and bump maps to your model 
 
When you initially load Artisan, you can see your model in the render window. Above the 
render window is the tab bar. Each tab will be explained in each step of this guide, with the 
first tab being Materials.  
 
To the right of the render window is the content panel. This panel contains different content 
(materials, lighting schemes and backgrounds) depending on which tab you currently have 
selected (in this step, it will be the Materials tab).  
 
Below the render window you have the toolbar. This contains buttons for navigation, 
rendering, taking SnapShots, and editing scene settings.  
 
See the Interface section for detailed information on the Artisan interface.  
 
The first step in the Artisan workflow is to apply materials, finishes and bumps to alter the 
appearance of the model. 

To apply a material to your model: 

1. With the Materials tab selected from the tab bar, select the Materials sub-tab from the 
sub-tab bar on the upper right hand side. 

 

2. Choose a material group from the drop-down menu then find the material you want to 
apply from the content panel. 

3. Click and hold down the left mouse button on the material, then drag it onto the 
model in the render window. 

4. Release the left mouse button and the material will be applied to the part of the model 
under the cursor. 

To change the finish or add a bump map: 

1. Select the Finishes or Bumps sub-tab from the sub-tab bar on the upper right hand side. 

  

2. Choose a group from the drop-down menu then find the finish or bump map you want 
to apply from the content panel. 

3. Click and hold down the left mouse button on the finish or bump map, then drag it 
onto part of the model. 

4. Release the left mouse button and it will be applied to the part of the model under the 
cursor. 

qthelp://com.lightworkdesign.irayplus/doc/help/interface/interface.html
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Bump maps that you have applied to your model will only appear when the SnapShot 
is rendered, unless you have the highest real-time quality selected in Edit > Preferences. 

 

Step 2: Applying a Lighting Scheme to your model 
 
Once you are happy with the materials you've applied, you can add a lighting scheme. <br 
To do this, select the Lighting tab from the main tab bar. 

  
 
Lighting schemes are split into two sub-tabs based on the type of model you have.  
 
Lighting schemes vary in complexity and accuracy to enable you to choose between render 
speed and lighting realism.  
More accurate and realistic lighting will take longer to render. 

To apply a lighting scheme to your scene: 

1. With the Lighting tab selected from the tab bar, select the Architectural, or Product sub-
tab from the sub-tab bar on the upper right hand side. 

  

2. Choose a lighting group from the drop-down menu then find the lighting scheme you 
want to apply from the content panel. 

3. Click and hold down the left mouse button on the lighting scheme, then drag it onto 
the render window. 

4. Release the left mouse button and the lighting scheme will be applied to the scene.  
This can take some time depending on the complexity of the scheme. 

 

Step 3: Choosing a 2D or 3D background for your model 
 
The next step is to choose either a 2D or 3D background to apply to your scene.  
 
To do this, select the Backgrounds tab from the tab bar. 

  
 
Backgrounds serve to quickly and easily provide context to your model in terms of scale and 
intended usage. A number of pre-defined background effects are supplied and you can 
supply your own image if required.  
 
2D backgrounds are fixed in screen space and require you to move you model to fit the 
background.  
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3D backgrounds provide a hemispherical image. As you navigate the view, the visible 
background changes. 

To apply a 2D or 3D background: 

1. With the Backgrounds tab selected from the tab bar, select the 2D Backgrounds or 3D 
Backgrounds sub-tab from the sub-tab bar on the upper right hand side. 

    

2. Choose a background group from the drop-down menu then find the background you 
want to apply from the content panel. 

3. Click and hold down the left mouse button on the background, then drag it onto the 
render window. 

4. Release the left mouse button and the background will be applied to the scene.  
This can take some time when using high quality 3D backgrounds. 

 

Step 4: Creating and Rendering SnapShots of your model 
 
The final step in this workflow is to create and render SnapShots of your model.  
 
To do this, select the SnapShots tab from the tab bar. 

  
 
SnapShots store all data of your scene so it can be brought back at any time. They can be 
created at any time by pressing the SnapShot button in the toolbar.  

  
 
SnapShots can be restored to the current scene by dragging and dropping them onto the 
render window. They replace all previously applied materials, lighting scheme, background 
and camera settings with those of the SnapShot.  
 
Once you have created all the SnapShots you require, the final stage is to render them out 
into high quality images. 

To create a SnapShot of a scene: 

1. Click on the Create SnapShot button in the toolbar. The SnapShot will appear in the 
SnapShots panel. 
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To apply a SnapShot: 

1. Click and hold down the left mouse button on a SnapShot in the SnapShots panel. 
2. Drag the SnapShot onto the render window then release the left mouse button and the 

SnapShot will be applied to the scene.  
This can take some time depending on the lighting scheme and shadows within the 
SnapShot. 

To render your SnapShot or sets of SnapShots: 

1. If not already selected, select the Render tab from the sub-tab bar on the upper right 
hand side. This will change the content panel to show options for rendering SnapShots. 

 

2. Click on the SnapShot you would like to render from the SnapShot panel below the 
render window. When the SnapShot is selected, it will gain a purple border around the 
image. 

To render more than one SnapShot, you can hold the Shift key and click more 
SnapShots to highlight a series, or hold the Ctrl key to add individual SnapShots. Another 
way to select multiple SnapShots is to hold the left mouse button down in the space 
around the SnapShots then drag a selection box over the ones you want to render. To 
select all SnapShots, left click into the SnapShot panel then press the Ctrl and A key 
together. 

3. Change the render options in the content panel to your preferences: 

o Change the file type by choosing one from the Output Format drop-
down menu. 

o Change the image resolution by choosing a size from the Longest Side 
(pixels) drop-down menu, or by entering your own value. The shortest 
side will be calculated based on the aspect ratio of the SnapShot. 

o Set the render, material and lighting quality by changing the values in 
the corresponding drop-down menus. 

 

4. Click on the Render Selected SnapShots button. 
5. The results of the rendering process will be delivered into the SnapShot folder beside 

your CAD model file. You can access the images quickly by double clicking each 
SnapShot in the SnapShot panel, or by clicking the Show Files button in the toolbar. 
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Artisan Glossary 
A glossary defining common terms used throughout Artisan. 

 

Keyword Definition 

Session The time spend using Artisan, from opening to closing. 

Bump / Bump 
Map 

Makes surfaces appear rough or have a pattern, based on different 
heights on the surface.  

Finishes Sets only the reflective and transparency of a material. Finishes can be 
applied onto of your current materials. 

Material A full definition of how an object will look. Materials define the finish, 
transparency and bump.  

SnapShots Used to store all data needed to replay your scene. SnapShots contain 
the materials, background, lighting and camera information. 

Why use 
SnapShots? 

Used correctly SnapShots become very useful. For example, to render a 
building in different lighting conditions simply take a number of SnapShots 
using different lighting schemes and then “Render Selected SnapShots”.  

Interactive 
Render 

A low quality image created from the render window. 

Render  A high quality, photo realistic image of the model.  
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